
 

  

BI4Dynamics Application 
Installation Manual for Dynamics 365 

Finance and Operations on Azure Virtual 

Machine 

Last update: March 2023 

Version 9.4 

Revision 1.5 



BI4Dynamics D365 F&O - Installation Manual Page 2 

Content 

1. Installation ...............................................................................................................................3 

1.1. Introduction ....................................................................................................................................................... 3 

1.2. Prerequisites ...................................................................................................................................................... 4 

1.3. Installing BI4Dynamics application ........................................................................................................... 5 

1.4. Creating BI4Dynamics instance .................................................................................................................. 7 

2. Implementation option A: Local Analysis Services ..............................................................8 

2.1. Adding data source – D365 F&O Cloud Source .................................................................................. 9 

2.2. Setting up instance ...................................................................................................................................... 17 

3. Implementation option B: Azure Analysis Services .......................................................... 19 

3.1. Adding data source – D365 F&O Cloud Source ............................................................................... 20 

3.2. Setting up instance ...................................................................................................................................... 28 

3.3. Installing On-premises Data Gateway .................................................................................................. 30 

3.4. Installing Azure Analysis Services ........................................................................................................... 32 

4. Implementation option C: Power BI Premium .................................................................. 36 

4.1. Adding Data source – D365 F&O Cloud Source ............................................................................... 37 

4.2. Setting up instance ...................................................................................................................................... 45 

4.3. Installing On-premises Data Gateway .................................................................................................. 47 

4.4. Completing Power BI Premium option installation ......................................................................... 49 

5. Managing instance ............................................................................................................... 52 

5.1. Edit instance ................................................................................................................................................... 52 

5.2. Copy instance ................................................................................................................................................. 53 

5.3. Edit process flow ........................................................................................................................................... 55 

5.4. Manage Partitions ........................................................................................................................................ 57 

5.5. Setup BI4Dynamics precision ................................................................................................................... 58 

5.6. Adding Calculation groups ....................................................................................................................... 59 

5.7. Deleting instance .......................................................................................................................................... 61 

6. Connecting Excel and Power BI reports ............................................................................. 62 

6.1. Downloading Excel and PowerBI reports ............................................................................................ 62 

6.2. Connecting Power BI reports ................................................................................................................... 62 

6.3. Connecting Excel reports ........................................................................................................................... 63 

 



BI4Dynamics D365 F&O - Installation Manual Page 3 

1. Installation 

1.1. Introduction 

This document covers the process of BI4Dynamics application installation on the Azure Virtual Machine 

(VM). 

 

It is comprised of prerequisites for BI4Dynamics installation, actual steps needed to execute the 

installation as well as instructions on managing the instance once it is created and connecting Excel and 

Power BI reports to the analytical database. 

 

The document oversees three options for installation based on where analytical database will be 

deployed: 

• Option A: Local Analytical Server – the best case in case you already have some excess 

computing capacities, is not recommended in conjunction with Azure VM due to not being a 

cost/performance effective option 

• Option B: Azure Analysis Server – dedicated Azure resource that hosts analytics. Is priced on 

per/hour basis, there is no limitation on number of users, however, performance will be impeded 

if numerous users a connected to low-tier analytics. 

• Option C: Power BI Premium Per User – costs 20$ per month/per user and provides superior 

performance 24/7. This option is recommended in case organization already applies Power BI 

Premium/PRO. Power BI Premium per User would also be a way to go for organizations that have 

just a few BI users.  

The data flow is as follows: 
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1.2. Prerequisites 

 Azure resources 

Azure Storage 

Description Value 

Subscription Pay-As-You-Go 

Resource Group vm-bi4-demo 

Azure Storage Account Name vmbi4demostorage 

Permissions: user is Contributor and Storage Blob data Contributor. 

 

Azure Synapse 

Description Value 

Serverless SQL endpoint bi4dynamicsuat-ondemand.sql.azuresynapse.net  

SQL admin username sqladminuser 

Azure Synapse Analytics Klrhvirehfqh33urf 

Permissions: AAD user (!) must be Synapse administrator on Synapse workspace. 

Azure SQL VM 

Description Value 

RDP Public IP (or RDP file) 51.132.66.72 

SQL server name (as seen in Azure) vm-bi4-demo.westeurope.cloudapp.azure.com 

VM Admin Account vm-admin-user 

VM Admin Account Password 6!dJ2yS34MbbQiPHs@rd 

Permissions: this user is administrator (default). 

 

Azure Analysis Services option: 

Description Value 

Azure Analysis Services asazure://westeurope.asazure.windows.net/bi4dynamicshybrid 

Username (AAS admin) mg@bi4dynamics.com 

Password Qpewoicsj490wkss 

Permissions: user is administrator. 

 

Power BI Premium option: 

Description Value 

Azure Analysis Services powerbi://api.powerbi.com/v1.0/myorg/BI4Dynamics%20XML%20

endpoint 

Username (AAS admin) pa@bi4dynamics.com 

Password Qpdggfweicsj490wkss 

Permissions: user is workspace administrator. 

  

mailto:mg@bi4dynamics.com
mailto:pa@bi4dynamics.com
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 D365 F&O credentials 

Description Value 

D365 F&O Admin User adminuser@bi4dynamics.onmicrosoft.com 

D365 F&O Admin User Password rtPxXqxJ2lkOIJFR9Eki#8 

Permissions: user must be administrator in DFO (no need to share this credential with BI4Dynamics or 

installation partner, just needed to be entered at the time of installation), 

1.3. Installing BI4Dynamics application 

IMPORTANT! Before installing BI4Dynamics, please check hardware and software requirements, make 

sure you have sufficient permissions and an active internet connected. 

IMPORTANT! The installation process must be started on VM where BI4Dynamics Data Warehouse will 

be created. 

1. Double-click BI4Dynamics.exe to start the installation*.  

*Always start BI4Dynamics as an administrator. 

Note: The name of the file varies based on the version you are using. 

2.  Follow the instructions on screen and accept the license agreement. 

 

 

3. Choose Default or Express option 

 

 

 

 

 

 

 

 

 

 

 

mailto:adminuser@bi4dynamics.onmicrosoft.com
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4. The installer will check for some of the prerequisites. If any of the tests will fail you can click on the 

result to see the error. You must fix the problem before repeating the test. Once all the tests are 

successfully completed you can continue with the installation. 

 

5. If a correct version of Shared Management Objects, Analysis Management Objects or .NET Framework 

is not installed, please click the Install button, which will trigger the installation of correct version of 

SMO’s, AMO’s, CLR Types or .NET Framework. 

 

6. Select the folder where you would like to install BI4Dynamics. You can choose to create a shortcut on 

the desktop and/or in the start menu. Click Next. 

 

 

 

 

 

 

 

 

 

 

 

7. Confirm the configuration and begin the installation of BI4Dynamics. 

 

8. Click Finish after the installation is completed. 
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1.4. Creating BI4Dynamics instance 

Deploying a BI4Dynamics solution is a seven-step process: 

1. Providing license information 

2. Creating an instance 

3. Adding the data sources 

4. Selecting global dimensions 

5. Selecting companies 

6. Selecting Framework module 

7. Completing installation 

When you open the application, an instance wizard will start to guide you through the configuration. 

 Providing license information 

1) Launch BI4Dynamics.exe from the folder where BI4Dynamics was installed to open the 

application. 

 
Note: BI4Dynamics is 64-bit application, but the default installation location is C:\Program Files (x86)\BI4Dynamics 

AX. Application can also be started from the Desktop shortcut or from the Start Menu shortcut. 

2) Enter the BI4Dynamics online license key   

OR 

3) Follow the instructions on screen to receive an offline license key (in case you do not have the 

internet connection or port 80 on the server is closed). 

 
Note: If you experience any problems with authorization, please contact us via support@bi4dynamic.com.  

4) Click Next. 

  

mailto:support@bi4dynamic.com
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2. Implementation option A: Local Analysis Services  

Instance properties 

1. Type the Name of the new instance. 

2. Select what Language the solution will be deployed in.  

SQL server 

3. Keep or change Database Name of the BI4Dynamics Data Warehouse.  

4. Type SQL server name (Use local server name). 

5. Select or Type in the SQL Server Instance name where the BI4Dynamics Data Warehouse will be 

deployed. 

6. Authentication type: Windows 

Analysis Services 

7. Keep or change the Analysis Database Name of the Analysis Services instance. 

8. Keep or change the Analysis Database Server name where the Analysis Services model will be 

deployed. 

9. Authentication type: Windows. 

Integration Services 

10. Check SQL Integration Service to process BI4Dynamics using the Integration services (parallel 

processing). 

 

Refresh 

11. Click Refresh to set default values for SQL Database file Locations (data and log files) and SQL 

Database Collation are entered automatically. Modify if necessary. 

 

 

Click Next. 
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2.1. Adding data source – D365 F&O Cloud Source 

 Setup BLOB Subscription  

This information is about adding Data Source(s) for BI4Dynamics instance. 

 

 
Setup Storage Account 

• Tenant ID and Account Name 

Open Azure portal and search for Storage accounts. 

 

Select and open the Storage account used for the installation. 

 

Copy and paste its Subscription ID and Account Name into corresponding field in the application. 
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• Blob Key 

Navigate to the storage account you use and select Access keys from the menu on the left. 

Unhide key1 and copy value to the corresponding field in the BI4Dynamics application. 

 

• Container Name  

Select Containers from the menu on the left. Select the container that you will be using. 
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• Folder Name 

Select the folder that correspond to Microsoft Dynamics instance you are connecting. 

 

Copy Folder name and paste it into corresponding field in BI4Dynamics application. 

Enter all parameters and press Test connection to Data Lake. 

 

 

Following window should appear: 
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 Setup Azure Synapse 

1. In storage account navigate to Shared access signature from the menu on the left. 

2. Select all three options under Allowed resource types. 

3. Select Start and Expiry date (usually 1 year) 

4. Press Generate SAS and connection string. 

5. Copy SAS token value. 

 

 
 

Open Azure portal and search for Azure Synapse Analytics. Select the Azure Synapse Analytics you are 

using. 

 
 

Select Access control (IAM) from the menu on left. Press View my access button and make sure you 

have Owner resource role. 
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Come back to Overview tab of Synapse Analytics and Open Synapse Studio. 

 
 

Navigate to Develop tab. 

 
Press + and select SQL script from the pop-up menu. 

 
Prepare script with shared access signature, paste it into the newly opened query, edit it and click Run. 

 

 SQL script template 

CREATE CREDENTIAL [https://@storageAccount.dfs.core.windows.net/@containerName] WITH 

IDENTITY = 'SHARED ACCESS SIGNATURE', SECRET = '@SAS Token' 

 

Replace parameters with real values: 

Parameter Description  Value (example) 

@storageAccount Name of the storage 

account 

bi4dynamicsuat 

@containerName Container name dynamics365-financeandoperations 

@SAS Token 

 

Value you have generated 

in previous steps; delete 

the first character in 

token string “?” 

sv=2020-08-

04&ss=bfqt&srt=sco&sp=rwdlacupx&se=2022-

02-01T21:33:14Z&st=2023-02-

01T13:33:14Z&spr=https&sig=KS%2ULlnU%3D 
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Prepared SQL script (example):  

 

CREATE CREDENTIAL [https://bi4dynamicsuat.dfs.core.windows.net/dynamics365-

financeandoperations] WITH IDENTITY = 'SHARED ACCESS SIGNATURE', SECRET = 'sv=2020-08-

04&ss=bfqt&srt=sco&sp=rwdlacupx&se=2022-02-01T21:33:14Z&st=2023-02-

01T13:33:14Z&spr=https&sig=KS%2ULlnU%3D' 

 

Important:   

Once the Expiry Date of Storage Account is reached, the application would not be able to connect to 

DFO services. To make the connection we need to set a new Expiry Date in Shared Access Signature 

tab of Storage Account and update credentials in Synapse Studio. 

 

Note: 

Before adding updated credentials with a new SAS Token, you need to use DROP CREDENTIAL to 

remove the old script with credentials and only after that the new SQL Script Template with the 

updated values can be executed. 

 

Navigate to Manage tab. Select Access control tab from the menu on the left. Press Add button and 

grant Synapse Administrator permissions to the user that will be used by BI4Dynamics application. 

 

• Serverless SQL endpoint and SQL admin username 

Come back to Overview page of Synapse workspace. Copy SQL admin username and Serverless SQL 

endpoint. 
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Enter all parameters and press Test connection and setup a Synapse. 

 
Following window should appear: 

 
 

 Setup Dynamics 365 AX Connector 

• Service hostname URL - link to Microsoft Dynamics Finance and Operations 

(abccorp.operations.dynamics.com). 

• Tenant ID – same as Blob Tenant ID. 

• Client app id 

Open Azure portal and search for App registrations. 

 
 

Select BI4Dynamics app. 
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Copy Application (client) ID value. 

 

• Client secret key 

Select Certificates & secrets from the menu on the left. Create a new client secret and save value, since 

it will not be possible to get it later. 

 

• Username & Password to Microsoft Dynamics. 

Test connection to AX Services, following window should appear: 

 
 

Once all credentials are imported, press Add Data source and wait… 

After source is added your screen should look like this: 

 
 

You have successfully added data source 

Click Next. 
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2.2. Setting up instance 

 Selecting Global Dimensions 

Add global financial dimensions from your D365 F&O. 

 

 Selecting Companies 

1. From the list of companies tick the ones you want to include in your instance and configure 

additional settings for each selected company:  

a. Local Currency: local currency code (e.g. GBP) – get data from D365 F&O. 

b. Additional Currency: select the additional currency code for this company (e.g. USD). 

c. Select Language ID from the pop-up menu. 

d. Add financial dimension and relate them with global financial dimensions. 

 

2. Click Next. 

 Selecting Modules 

Select Framework module.  

 
Click Next. 
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 Completing installation 

Open Deploy tab and make sure Keep Data Warehouse and Keep Analysis Database are checked 

 
Move to Install tab and click Installation button. 

 
 

On the Installation screen, uncheck #9 Process Instance, click Run 

 
 

Wait for the “Installation Completed” message. 

 

 

 

 

 

 

Open Process tab and press Process button 

 
Wait until the instance is processed 

 
 

You have successfully deployed and processed data warehouse and analytics. 
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3. Implementation option B: Azure Analysis Services  

If you plan to use Azure Analysis Services, complete chapters Installing On-premises Data 

Gateway and Installing Azure Analysis Services. Come back when finished. 

 

Instance properties 

1. Type the Name of the new instance. 

2. Select what Language the solution will be deployed in.  

SQL server 

3. Keep or change Database Name of the BI4Dynamics Data Warehouse.  

4. Type SQL server name (Use local server name). 

5. Select or Type in the SQL Server Instance name where the BI4Dynamics Data Warehouse will be 

deployed. 

Azure Analysis Services 

• SQL Analysis Server name: enter the name of the Azure Analysis Services (see in Chapter 2) 

• Authentication: Azure Active Directory 

• Username: email of the admin user (adminuser@domain.com) that has been entered when creating 

Azure Analysis Services 

• Password: enter password for Azure Active Directory  

 

Integration Services 

Check SQL Integration Service to process BI4Dynamics using the Integration services (parallel 

processing). 

 

Refresh 

Click Refresh to set default values for SQL Database file Locations (data and log files) and SQL 

Database Collation are entered automatically. Modify if necessary. 

 

Click Next. 

mailto:adminuser@domain.com
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3.1. Adding data source – D365 F&O Cloud Source 

 Setup BLOB Subscription  

This information is about adding Data Source(s) for BI4Dynamics instance. 

 

 
Setup Storage Account 

• Tenant ID and Account Name 

Open Azure portal and search for Storage accounts. 

 

Select and open the Storage account used for the installation. 

 

Copy and paste its Subscription ID and Account Name into corresponding field in the application. 
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• Blob Key 

Navigate to the storage account you use and select Access keys from the menu on the left. 

Unhide key1 and copy value to the corresponding field in the BI4Dynamics application. 

 

• Container Name  

Select Containers from the menu on the left. Select the container that you will be using. 
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• Folder Name 

Select the folder that correspond to Microsoft Dynamics instance you are connecting. 

 

Copy Folder name and paste it into corresponding field in BI4Dynamics application. 

Enter all parameters and press Test connection to Data Lake. 

 

 

Following window should appear: 
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 Setup Azure Synapse 

6. In storage account navigate to Shared access signature from the menu on the left. 

7. Select all three options under Allowed resource types. 

8. Select Start and Expiry date (usually 1 year) 

9. Press Generate SAS and connection string. 

10. Copy SAS token value. 

 

 
 

Open Azure portal and search for Azure Synapse Analytics. Select the Azure Synapse Analytics you are 

using. 

 
 

Select Access control (IAM) from the menu on left. Press View my access button and make sure you 

have Owner resource role. 
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Come back to Overview tab of Synapse Analytics and Open Synapse Studio. 

 
 

Navigate to Develop tab. 

 
 

Press + and select SQL script from the pop-up menu. 

 
Prepare script with shared access signature, paste it into the newly opened query, edit it accordingly and 

click Run. 

 

 SQL script template 

CREATE CREDENTIAL [https://@storageAccount.dfs.core.windows.net/@containerName] WITH 

IDENTITY = 'SHARED ACCESS SIGNATURE', SECRET = '@SAS Token' 

 

Replace parameters with real values: 

Parameter Description  Value (example) 

@storageAccount Name of the storage 

account 

bi4dynamicsuat 

@containerName Container name dynamics365-financeandoperations 

@SAS Token 

 

Value you have generated 

in previous steps; delete 

the first character in 

token string “?” 

sv=2020-08-

04&ss=bfqt&srt=sco&sp=rwdlacupx&se=2022-

02-01T21:33:14Z&st=2023-02-

01T13:33:14Z&spr=https&sig=KS%2ULlnU%3D 
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Prepared SQL script (example):  

 

CREATE CREDENTIAL [https://bi4dynamicsuat.dfs.core.windows.net/dynamics365-

financeandoperations] WITH IDENTITY = 'SHARED ACCESS SIGNATURE', SECRET = 'sv=2020-08-

04&ss=bfqt&srt=sco&sp=rwdlacupx&se=2022-02-01T21:33:14Z&st=2023-02-

01T13:33:14Z&spr=https&sig=KS%2ULlnU%3D' 

 

Important:   

Once the Expiry Date of Storage Account is reached, the application would not be able to connect to 

DFO services. To make the connection we need to set a new Expiry Date in Shared Access Signature 

tab of Storage Account and update credentials in Synapse Studio. 

 

Note: 

Before adding updated credentials with a new SAS Token, you need to use DROP CREDENTIAL to 

remove the old script with credentials and only after that the new SQL Script Template with the 

updated values can be executed. 

 

Navigate to Manage tab. Select Access control tab from the menu on the left. Press Add button and 

grant Synapse Administrator permissions to the user that will be used by BI4Dynamics application. 

 

• Serverless SQL endpoint and SQL admin username 

Come back to Overview page of Synapse workspace. Copy SQL admin username and Serverless SQL 

endpoint. 
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Enter all parameters and press Test connection and setup a Synapse. 

 
 

Following window should appear: 

 

 Setup Dynamics 365 AX Connector 

• Service hostname URL - link to Microsoft Dynamics Finance and Operations 

(abccorp.operations.dynamics.com). 

• Tenant ID – same as Blob Tenant ID. 

• Client app id 

Open Azure portal and search for App registrations. 

 
 

Select BI4Dynamics app. 

 
 

Copy Application (client) ID value. 
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• Client secret key 

Select Certificates & secrets from the menu on the left. Create a new client secret and save value, since 

it will not be possible to get it later. 

 

• Username & Password to Microsoft Dynamics. 

Test connection to AX Services, following window should appear: 

 
 

Once all credentials are imported, press Add Data source and wait… 

After source is added your screen should look like this: 

 
 

You have successfully added data source 

Click Next. 
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3.2. Setting up instance 

 Selecting Global Dimensions 

Add global financial dimensions from your D365 F&O. 

 

 Selecting Companies 

3. From the list of companies tick the ones you want to include in your instance and configure 

additional settings for each selected company:  

a. Local Currency: local currency code (e.g. GBP) – get data from D365 F&O. 

b. Additional Currency: select the additional currency code for this company (e.g. USD). 

c. Select Language ID from the pop-up menu. 

d. Add financial dimension and relate them with global financial dimensions. 

 

4. Click Next. 

 Selecting Modules 

Select Framework module.  

 
Click Next. 
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 Completing installation 

Open Deploy tab and make sure Keep Data Warehouse and Keep Analysis Database are checked 

 
Move to Install tab and click Installation button. 

 
 

On the Installation screen, uncheck #9 Process Instance, click Run 

 
 

Wait for the “Installation Completed” message. 
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3.3. Installing On-premises Data Gateway 

When you choose to install analytics as Azure Analysis Services, you need to install following: 

- Azure Analysis Service in Azure portal 

- On-Premises Gateway on your BI server 

We recommend to first install On-premises Gateway and later Azure Analysis Services as we enter 

parameters from on-Premises gateway to Azure Analysis Service settings. 

 Install On-Premises data gateway on virtual machine 

Download On-Premises data gateway to virtual machine 

Download On-Premises Data gateway from Microsoft site: 

https://www.microsoft.com/en-us/download/details.aspx?id=53127 

 

Install On-premises data gateway 

Follow the documentation from Microsoft site: 

https://docs.microsoft.com/en-us/data-integration/gateway/service-gateway-install 

 

Note: Please be very careful when selecting the right region.  Installation process will set On-Premises 

Gateway to your default region that may not be the same as Azure Analysis Services. The feature is not 

so exposed during installation so it can easily go unnoticed. 

 

 

If you have set the wrong Region, and your Gateway does not appear in the available list of gateways of 

your Azure Analysis Services than you must re-install On-Premises data gateway. 

 

 

 

 

 

 

 

https://www.microsoft.com/en-us/download/details.aspx?id=53127
https://docs.microsoft.com/en-us/data-integration/gateway/service-gateway-install
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 Setup On-Premises Data Gateway as Azure Service 

Go to Azure portal  

Click on icon On-premises Data Gateway 

 
Click on + New 

 

Enter all fields: 

- Resource name 

- Subscription 

- Resource group 

- Location 

- Installation name: select on-premises gateway that 

you have created in previous step from the list of 

available gateways 

 

Then click Create 

 

Click Go to Resource: 

 

You have successfully created an On-premises Data Gateway as Azure Service. 

On-premises Data Gateway must be selected on Azure Service like Azure Analysis Services that will use 

this gateway to receive On-premises data. 
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3.4. Installing Azure Analysis Services 

Analysis Services can be deployed on:  

A. Same computer that is hosting Data Warehouse (VM or Local Server) 

Use this for BI development instance and when users connect to service that is running in LAN (local 

area network) 

B. As Azure Analysis Services 

Use this option (also described as Hybrid option) for most Production environments where users 

connect to service with AAD (Azure Active Directory). 

  

In this chapter option B is described.  

 Create Azure Analysis Services 

Before installing BI4Dynamics app you need to have available Azure Analysis Services that will host 

BI4Dynamics database. 

 

Go to Azure portal, find Analysis Services and click +Add  

 
 

Enter the following fields: 

- Server name: unique name of Analysis Server 

- Subscription 

- Resource group 

- Location 

- Pricing tier  

Database size (GB) will depend on data type, cardinality, and 

number of rows in your data warehouse  

QPUS (number of processing units) will depend on database size 

and number of users that will query the data 

 

Suggestion: start with lower tier, check if data can fit into database 

and if response time from your BI tool (Excel or Power BI) is good 

enough. If not, go for higher tier. It takes 60 seconds to change tier 

to next level. 

 

Click Create 

 
 

You have successfully created Azure Analysis Services  
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Go to resource and copy Server name to notepad as it will be used in BI4Dynamics app installation. 

 
 

In our example server name is: asazure://westeurope.asazure.windows.net/bi4dynamicshybrid 

 Connect to Azure Analysis Services 

To verify installation, connect to Analysis Services Server use SSMS (SQL Server Management Studio) 

and enter: 

- Server Type: Analysis Services 

- Server name 

- Authentication: Azure Active Directory 

- Username 

- Password 

Here is a database that we have just created: 
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 Select On-Premises Data Gateway 

On-Premises Data Gateway is needed when Azure Service received data from On-Premises. When Azure 

Analysis Services is receiving data from On-Premises source than this option must be selected. 

 

Click on On-premises data gateway 

And Pick an On-Premises Data Gateway to connect 

 
Click Connect selected gateway. 

Gateway is now connected: 
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Open Process tab and press Process button 

 
 

Wait until the instance is processed 

 
 

You have successfully deployed and processed data warehouse and analytics. 
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4. Implementation option C: Power BI Premium 

If you plan to use Azure Analysis Services, complete chapters Installing On-premises Data 

Gateway and Installing power BI Premium workspace. Come back when finished. 

 

Instance properties 

1. Type the Name of the new instance. 

2. Select what Language the solution will be deployed in.  

SQL server 

3. Keep or change Database Name of the BI4Dynamics Data Warehouse.  

4. Type SQL server name (Use local server name). 

5. Select or Type in the SQL Server Instance name where the BI4Dynamics Data Warehouse will be 

deployed. 

Analysis Services 

• Analysis Database Name: define how XMLA endpoint should be called 

• SQL Analysis Server Option: select Power BI (XMLA endpoint) 

• Authentication: Azure Active Directory 

• Username: email of the admin user (adminuser@domain.com) that has been entered when creating 

Azure Analysis Services 

• Password: enter password for Azure Active Directory  

• Workspace: paste the link to the Power BI XMLA endpoint 

Integration Services 

Check SQL Integration Service to process BI4Dynamics using the Integration services (parallel 

processing). 

Refresh 

Click Refresh to set default values for SQL Database file Locations (data and log files) and SQL 

Database Collation are entered automatically. Modify if necessary. 

This is how setting should look (showing Power BI Premium option): 

 
Click Next. 

mailto:adminuser@domain.com
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4.1. Adding Data source – D365 F&O Cloud Source 

 Setup BLOB Subscription  

This information is about adding Data Source(s) for BI4Dynamics instance. 

 

 
Setup Storage Account 

• Tenant ID and Account Name 

Open Azure portal and search for Storage accounts. 

 

Select and open the Storage account used for the installation. 

 

Copy and paste its Subscription ID and Account Name into corresponding field in the application. 
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• Blob Key 

Navigate to the storage account you use and select Access keys from the menu on the left. 

Unhide key1 and copy value to the corresponding field in the BI4Dynamics application. 

 

• Container Name  

Select Containers from the menu on the left. Select the container that you will be using. 
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• Folder Name 

Select the folder that correspond to Microsoft Dynamics instance you are connecting. 

 

Copy Folder name and paste it into corresponding field in BI4Dynamics application. 

Enter all parameters and press Test connection to Data Lake. 

 

 

Following window should appear: 
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 Setup Azure Synapse 

11. In storage account navigate to Shared access signature from the menu on the left. 

12. Select all three options under Allowed resource types. 

13. Select Start and Expiry date (usually 1 year) 

14. Press Generate SAS and connection string. 

15. Copy SAS token value. 

 

 
 

Open Azure portal and search for Azure Synapse Analytics. Select the Azure Synapse Analytics you are 

using. 

 
 

Select Access control (IAM) from the menu on left. Press View my access button and make sure you 

have Owner resource role. 
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Come back to Overview tab of Synapse Analytics and Open Synapse Studio. 

 
 

Navigate to Develop tab. 

 
Press + and select SQL script from the pop-up menu. 

 
Prepare script with shared access signature, paste it into the newly opened query, edit it accordingly and 

click Run. 

 

 SQL script template 

CREATE CREDENTIAL [https://@storageAccount.dfs.core.windows.net/@containerName] WITH 

IDENTITY = 'SHARED ACCESS SIGNATURE', SECRET = '@SAS Token' 

 

Replace parameters with real values: 

Parameter Description  Value (example) 

@storageAccount Name of the storage 

account 

bi4dynamicsuat 

@containerName Container name dynamics365-financeandoperations 

@SAS Token 

 

Value you have generated 

in previous steps; delete 

the first character in 

token string “?” 

sv=2020-08-

04&ss=bfqt&srt=sco&sp=rwdlacupx&se=2022-

02-01T21:33:14Z&st=2023-02-

01T13:33:14Z&spr=https&sig=KS%2ULlnU%3D 



BI4Dynamics D365 F&O - Installation Manual Page 42 

Prepared SQL script (example):  

 

CREATE CREDENTIAL [https://bi4dynamicsuat.dfs.core.windows.net/dynamics365-

financeandoperations] WITH IDENTITY = 'SHARED ACCESS SIGNATURE', SECRET = 'sv=2020-08-

04&ss=bfqt&srt=sco&sp=rwdlacupx&se=2022-02-01T21:33:14Z&st=2023-02-

01T13:33:14Z&spr=https&sig=KS%2ULlnU%3D' 

 

Important:   

Once the Expiry Date of Storage Account is reached, the application would not be able to connect to 

DFO services. To make the connection we need to set a new Expiry Date in Shared Access Signature 

tab of Storage Account and update credentials in Synapse Studio. 

 

Note: 

Before adding updated credentials with a new SAS Token, you need to use DROP CREDENTIAL to 

remove the old script with credentials and only after that the new SQL Script Template with the 

updated values can be executed. 

Navigate to Manage tab. Select Access control tab from the menu on the left. Press Add button and 

grant Synapse Administrator permissions to the user that will be used by BI4Dynamics application. 

 

• Serverless SQL endpoint and SQL admin username 

Come back to Overview page of Synapse workspace. Copy SQL admin username and Serverless SQL 

endpoint. 
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Enter all parameters and press Test connection and setup a Synapse. 

 
 

Following window should appear: 

 

 Setup Dynamics 365 AX Connector 

• Service hostname URL - link to Microsoft Dynamics Finance and Operations 

(abccorp.operations.dynamics.com). 

• Tenant ID – same as Blob Tenant ID. 

• Client app id 

Open Azure portal and search for App registrations. 

 
 

Select BI4Dynamics app. 
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Copy Application (client) ID value. 

 

• Client secret key 

Select Certificates & secrets from the menu on the left. Create a new client secret and save value, since 

it will not be possible to get it later. 

 

• Username & Password to Microsoft Dynamics. 

Test connection to AX Services, following window should appear: 

 
 

Once all credentials are imported, press Add Data source and wait… 

After source is added your screen should look like this: 

 
 

You have successfully added data source 

Click Next. 
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4.2. Setting up instance 

 Selecting Global Dimensions 

Add global financial dimensions from your D365 F&O. 

 

 Selecting Companies 

5. From the list of companies tick the ones you want to include in your instance and configure 

additional settings for each selected company:  

a. Local Currency: local currency code (e.g. GBP) – get data from D365 F&O. 

b. Additional Currency: select the additional currency code for this company (e.g. USD). 

c. Select Language ID from the pop-up menu. 

d. Add financial dimension and relate them with global financial dimensions. 

 

6. Click Next. 

 Selecting Modules 

Select Framework module.  

 
Click Next. 
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 Completing installation 

Open Deploy tab and make sure Keep Data Warehouse and Keep Analysis Database are checked 

 
 

Move to Install tab and click Installation button. 

 
 

On the Installation screen, uncheck #9 Process Instance, click Run 

 
Wait for the “Installation Completed” message. 
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4.3. Installing On-premises Data Gateway 

When you choose to install analytics as Azure Analysis Services, you need to install following: 

- Azure Analysis Service in Azure portal 

- On-Premises Gateway on your BI server 

We recommend to first install On-premises Gateway and later Azure Analysis Services as we enter 

parameters from on-Premises gateway to Azure Analysis Service settings. 

 Install On-Premises data gateway on virtual machine 

Download On-Premises data gateway to virtual machine 

Download On-Premises Data gateway from Microsoft site: 

https://www.microsoft.com/en-us/download/details.aspx?id=53127 

 

Install On-premises data gateway 

Follow the documentation from Microsoft site: 

https://docs.microsoft.com/en-us/data-integration/gateway/service-gateway-install 

 

Note: Please be very careful when selecting the right region.  Installation process will set On-Premises 

Gateway to your default region that may not be the same as Azure Analysis Services. The feature is not 

so exposed during installation so it can easily go unnoticed. 

 

 

  

https://www.microsoft.com/en-us/download/details.aspx?id=53127
https://docs.microsoft.com/en-us/data-integration/gateway/service-gateway-install
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1. Open Power BI portal, press Workspaces and Create a workspace. 

 

2. Name the workspace and select Premium per user under License mode 

 

3. Navigate to your Workspace 
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4. Press Settings button 

 

5. Select Premium tab and Premium per user option and copy Workspace Connection. 

Link should look like that: powerbi://api.powerbi.com/v1.0/myorg/BI4Dynamics%20PPU%20TEST  

 

4.4. Completing Power BI Premium option installation 

Open SQL Server Management Studio and connect to Power BI workspace. Newly created analysis 

database should have tables, which are currently still empty since data is not yet processed. 

 
 

Connect to local Database SQL server to check that instance database has been created. 

 
  

mailto:d
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Add this database as data source, to do that open Power BI portal and navigate to Manage gateways. 

 
Add new data source and press Apply. 

  
 

Make sure that connection was established successfully. 

 
 

Relate Power BI database with gateway data source. To do that navigate to your workspace. 

 
 

Press three-dot sign and select Settings from the pop-up menu 
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Under Gateway connection select the gateway you have installed on your computer and map gateway 

to the data source used, click Apply. 

 
 

Open Process tab and press Process button 

 
Wait until the instance is processed 

 
 

You have successfully deployed and processed data warehouse and analytics. 
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5. Managing instance 

5.1. Edit instance 

To edit existing BI4Dynamics instance do the following: 

1. Open instance 

2. Click on File and press Edit 

 

3. Make changes to instance. For example, in order to move analysis services to Azure change 

Authentication to “Azure Active Directory” and input username and password to Azure portal in 

the corresponding fields. 

 

4. Click Save & Restart Instance. 
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5.2. Copy instance 

To copy an existing BI4Dynamics instance do the following: 

5. Open instance 

6. Click on File and press Edit 

 

7. Check Copy current instance and enter name for the instance that you create. 

Note: copy name and all other modifications, i.e. database name, analysis database name are saved to 

the copy, not current instance. 

 

8. Press Copy Instance button, button is disabled when entered settings are not valid - instance with such 

name already exists, connection to servers cannot be established, etc. 

9. Open copied instance, navigate to Deploy tab and Click on Deploy All. 

 

10.  Once the instance is successfully deployed open Customize tab, make sure Update from Instance 

folder is selected, and Get Metadata. 
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11. As a last step, Open Process tab and click Process. 

 
 

 

You have successfully copied an instance. 

  



BI4Dynamics D365 F&O - Installation Manual Page 55 

5.3. Edit process flow 

Process flow is used to determine the sequence of execution of stored procedures when processing data 

with BI4Dynamics. Editing process flow is completely optional and it is usually connected with custom 

development.  

 Explanation of process flow top form functionality 

 

1. Edit existing Process flow or Add a new one 

2. Reset the Process flow (return to original state) or Reload Process flow (include stored procedures 

saved in BI4Dynamics folder structure) 

3. Select Full or Incremental Processing type 

4. Process All (Stage, Data Warehouse and Analysis Database) 

5. Process just one on the above. 

6. Create a new Object Group (standard 1-13) 

7. Add or Remove a SSIS package from file 

 Explanation of process flow table functionality 

  

1. Object group name.  

All stored procedures within object group are executed before the next Object group is executed. 

Each Object group forms a separate SSIS package which is executed on processing.  

2. Select/unselect a stored procedure to be executed on processing 

3. Run the stored procedure manually from the application 

4. Object subgroup name. Stored procedures within an Object subgroup are executed successively, 

while different Object subgroups within same Object group are executed in parallel.  

5. Rename Object Subgroup option 
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 Moving stored procedure from one object group to another 

 
Right-click on a stored procedure gives you an option to move it to a different Object group if needed 

(on reset Process flow the stored procedure will be moved back to original Object subgroup).  

 Setting up process flow property manually in stored procedure 

Permanently moving a stored procedure to a different Object group is possible by adding a DECLARE 

clause in the stored procedure itself:  

 
By adding or changing declare statement store procedure’s execution flow is determined. 
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5.4. Manage Partitions 

Partitions divide portions of data you need to process (refresh) frequently from data that can be 

processed less frequently. For example, a fact table may include certain row sets that contain data that 

rarely changes, but other row sets have data that changes often. There's no need to process all of the 

data when only a portion of it needs to be processed. 

 

Partitions work by dividing a table into logical partition objects. Individual partitions, each containing a 

unique segment of data, can then be incrementally processed either sequentially or in parallel 

independent of other partitions, or excluded from processing operations altogether. 

 

This feature can be only used with SQL server enterprise edition or with PowerBI premium. 

 

 

1. Open the Customize ribbon 

2. Select Manage Partitions 

 
 

1. Select the Cube. 

2. Select the Fact. 

3. Select the Date field to Partition by. 

4. Select the number of last partitions processed (this is determined by how much backdating is 

done). 

5. Deploy the fact. 

6. Process. 
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5.5. Setup BI4Dynamics precision 

Numeric data types can be stored in SQL with different precision, scale, and length.  

Precision is the total number of digits that can be stored both to the left and right of the decimal place.  

Scale is the number of digits to the right of the decimal point in a number. 

Length is the number of bytes that are used to store the number. 

 

In SQL the default maximum precision and scale for a particular length is the following: 

• 19,5   =   9 bytes 

• 27,10 = 13 bytes 

• 38,20 = 17 bytes  

During the installation, the following error might occur on stage: 

 

It should be addressed by increasing the precision (e.g. from 19 to 38) and scale (e.g. from 5 to 20). 

The default maximum precision of numeric and decimal data types is 38. 

To change it in application you need to: 

1. Open the instance and click File > Properties. 

 

2. Under Instance Setup > Data Warehouse Properties precision could be set up for: 

• Stage tables 

• Datawarehouse tables 
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5.6. Adding Calculation groups 

Calculation groups are a collection of items, which are treated as a dimension but are in fact a collection 

of measures. Usually, calculation groups are created in Tabular Editor, however, BI4Dynamics provides 

several calculation groups out of the box and makes creating new calculation groups easier. 

 

For example, using Calculation Group functionality, one can create P&L calculation group, that would 

include all components of P&L such as Net Sales, Operating Profit, etc. without need to pick all measures 

separately. P&L “dimension” simply should be placed on rows, Date dimension on columns. 

 

The result would be as follows: 

 
To create calculation groups: 

1. Open Tabular editor 

2. Go to File > Open > From DB 

3. Select the Server and Instance where you want to create calculation groups 

4. Select Model and New Calculation group 
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5. Add new Calculation items with DAX query  

 

6. Right click the new Calculation group, select Script > Create or Replace > To Clipboard 

 

7. Open BI4Dynamics application and open instance 

8. Go to Customize tab > Manage Dimensions 

9. Select New Calc. Group, add a name and copy the script 

 

10. Update and Generate all under Calculation groups 

11. Deploy and Process analysis database 
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5.7. Deleting instance 

1. Open the instance you would like to delete by clicking File and selecting the instance in the list 

on the right. 

2. Click File > Delete. 

3. Click Yes to confirm the action. 

IMPORTANT! When deleting an instance, the Data Warehouse and Analysis Database will be deleted.  

Note: BI4Dynamics Instance folders and the log file are not removed during the delete process.  

Uninstalling BI4Dynamics 

1. Click Start > Settings > Control Panel. 

2. Click Add or Remove Programs. 

3. From the list of installed programs, select BI4Dynamics. 

4. Click Remove. 

5. Follow the instructions on screen. 

IMPORTANT! User files will not be removed when uninstalling the solution. 
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6. Connecting Excel and Power BI reports 

6.1. Downloading Excel and PowerBI reports 

1. Open Instance 

2. Go to Install tab 

3. Click Download reports 

4. Select the destination 

5. Standard reports will be downloaded that are included with BI4Dynamics 

6.2. Connecting Power BI reports 

 Changing connection 

1. Open Power BI report 

2. Click Edit Queries > Data source settings 

 

3. Type the Server name to the Server field. Type the Database name to the Database field 

 

 Creating a new connection 

4. Open Power BI Desktop 

5. Click Get data 

6. Choose Analysis Services 

7. Type the Server name and Database name 

8. Choose Connect live 
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9. Click OK and start exploring your data 

You should see this screen: 

 
 

You have successfully connected Power BI to Analysis Services model. 

 

6.3. Connecting Excel reports  

 Changing connection 

1. Open Excel report 

2. Click Data > Connections > Properties >Definition 

3. Type the database name to the Initial Catalog property of 

the Connection string. Type the Server name to the Data 

source property of the Connection string. 

 Creating a new connection (local service) 

4. Open Microsoft Excel 

5. Click Data > Get External Data > From other Data source > 

From Analysis Services. 

 

6. Insert a Server name      
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do not enter “.” for local server as this connection will not work on another PC 

7. Click Next and select Analysis database from the dropdown menu and select Model 

  

 

8. Click Finish and OK on next form. 

 Creating a new connection (Azure Analysis Services) 

• Server Name – Azure Analysis Services: asazure://westus2.asazure.windows.net/bid365 

• Username and Password – to Azure Active Directory:  

 

 Creating a new connection (Power BI Premium) 

• Server Name – Power BI Premium workspace: 

powerbi://api.powerbi.com/v1.0/myorg/BI4Dynamics%20XML%20endpoint 

• Username and Password – to Power BI Premium portal:  
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9. Start exploring your data by dragging and dropping dimensions and measures in pivot table 

 

You have successfully connected Excel to Analysis Services model. 


